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Overview
The System Diagnostics solution provides a way for System Administrators to:

 l Monitor and diagnose overall environment performance and task health.

 l Examine application metrics and application data volumes. 

This solution helps to assure that the OneStream environment and applications are properly sized 
and efficiently configured, and gives System Administrators the tools to refresh resources.

System Diagnostics provides:

 l Detailed environment snapshot analysis across application and database servers.

 l Detailed application snapshot analysis of key metrics and data volumes.

 l Live monitoring across application and database servers.

 l Detailed task analysis including task concurrency, statistics, and counts.

 l Application server recycling.

Important: Access to System Diagnostics is limited to users with the System Administrator 
security role. This should be strictly enforced because of the accessibility to application 
information and controls.
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Setup and Installation
System Diagnostics can be installed within an existing OneStream application, yet it enables you 
to analyze performance of all applications in a given environment. See Install System Diagnostics 
for details. 

This section contains important details related to the planning, configuring, and installation of your 
solution. Before you install the solution, familiarize yourself with these details.

See also: MarketPlace Solution Modification Considerations

Dependencies
Component Description

OneStream 
6.2.0 or later

Minimum OneStream Platform version required to install this version of 
System Diagnostics.

Select the System Diagnostics Development 
Location 
Before beginning installation, decide whether to build the solution directly in the Production 
OneStream  application or in a separate Development OneStream application. This section 
provides some key considerations for each option. 

Production OneStream Application: The primary advantage of building the solution in a 
Production application is that you will not have to migrate the resulting work from a Development 
application. However, there are intrinsic risks when making design changes to an application used 
in a Production capacity and not advised. 

Note: OneStream strongly recommends that you implement the solution in the 
Development environment with a fresh copy of the Production application before starting 
work.

Development OneStream Application: As a best practice, use the Development OneStream 
application to build the solution. 
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Create the OneStream Development 
Application

 1. Ensure all the OneStream artifacts relating to System Diagnostics such as workflow profiles 
and entities are in the Production application.

 2. Copy your Production application to your Development environment and rename it. Use the 
development version for your System Diagnostics solution. 

Application Server Settings
You may need to edit the OneStream Application Server Configuration so users can create and 
change data in the additional database tables. If other MarketPlace solutions (such as Specialty 
Planning) are already in the application, these adjustments may already exist.

See also: Solution Database Migration Advice

Configure the OneStream Application Server
Be sure that the security group settings include the users who will be working on and setting up 
the solution before proceeding. 

Note: Group settings are applicable to all MarketPlace solutions; it is important to keep the 
group names generic.

 1. Start the OneStream Server Configuration Utility as an Administrator. 

 2. Click Open Application Server Configuration File > Database.

 3. Edit the following OneStream Database Server properties:

 l Access Group for Ancillary Tables: Select a group that includes those who will access 
records.

 l Can Create Ancillary Tables: True

 l Can Edit Ancillary Table Data: True
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 l Maintenance Group for Ancillary Tables: Select a group who will edit and maintain 
tables.

 l Table Creation Group for Ancillary Tables: Select a group who can create tables. 

 4. Restart Internet Information Server.

Note: The SQL Server account used for the OneStream application must have the View 
Server State Permission granted for System Diagnostics to access the SQL Server details. 
Also, the account running the OneStream application pool must be a local administrator on 
the server to recycle application servers.

Install System Diagnostics
Check the Release Notes to determine if uninstalling only the user interface or a full uninstall of 
the solution is necessary and then read that section for instructions. If the Release Notes indicate 
that an overinstall is allowed, then continue with these instructions.

 1. Download the System Diagnostics solution from the MarketPlace. The package is a zip file 
named OSD_PVx.x.x_SVzzz_PackageContents.zip where x.x.x and zzz represent version 
numbers for OneStream and the solution. The PVx.x.x number (for example, 600) 
represents the minimum Platform Version (6.0.0) required to implement this solution 
version.

 2. On the OneStream MarketPlace Dashboard, click MarketPlace > System Diagnostics.
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 3. On the System Diagnostics Solution page, select the appropriate OneStream platform 
version from the Minimum Platform Version drop-down list.

 4. Select the most recent version from the Solution Version drop-down list and then click 
Download.

 5. Log in to OneStream.

 6. On the Application tab, click Tools > Load/Extract.

 7. On the Load tab, locate the solution package using the Select File icons and click Open.

 8. When the solution’s file name appears, click Load.

 9. Click Close to complete the installation.

Set Up System Diagnostics
The first time you run System Diagnostics, you are guided through the table setup process.

In OneStream, click OnePlace > Dashboards > System Diagnostics > System Diagnostics.
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Create Tables
 1. Click Step 1: Setup Tables.

This step may be necessary when upgrading even if tables are already present. System 
Diagnostics does not drop any tables that already exist, but modifies table structures and 
add any new ones if necessary.

The following tables are created in the OneStream framework database:

The Snapshot Automation automation task is created and can be edited in the Task 
Scheduler. 

System Diagnostics Guide 6

Setup and Installation



Note: You should receive the  message Solution Table Created if this is a new 
implementation of System Diagnostics.  If updating a previous release which includes 
changes to these tables, the message reads Solution Tables Upgraded.

See Also:

 l Task Scheduler

 l The Task Scheduler section in the Application Tools chapter of the Design and 
Reference Guide.

 2. Click Step 2: Launch Solution to open System Diagnostics.

After setting up the solution’s tables, a task is created in Task Scheduler that takes Environment 
and Application snapshots on the third Saturday of each month. You can change the task 
frequency and timing using theTask Scheduler. 

Note: The Task Scheduler is currently only available when using the OneStream desktop 
application.

Package Contents
The Dashboard Maintenance Unit provides the user interface for System Diagnostics and 
includes the required dashboard groups, components, data adapters, parameters and files.

Business Rules
The following business rules are included:

OSD_HelperQueries
Dashboard Data Set Business Rule. This rule provides query functions for collecting the activity 
and environment analysis information using a combination of SQL and programmatic data. 

OSD_SolutionHelper
Dashboard Extender Business Rule. This rule provides various functions for the System 
Diagnostics solution and the Dashboard user interface. 
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OSD_ParamHelper
Dashboard XFBR String Business Rule. This rule provides conditional parameter processing 
functions that allow a parameter value to be interpreted and substituted with a different string.

OSD_LiveMonitoring
Extensibility Business Rule. This rule allows System Diagnostics to monitor system processing 
and collect metrics.  This Business Rules is intended to be called from a Data Management step.

OSD_ApplicationSnapshot
Extensibility Business Rule. This rule facilitates Application and Environment manual and Task 
Scheduled snapshots.

Data Management
The following Data Management Sequences and steps are used with their related Business Rules 
(as described above). The benefit of running these processes through a Data Management 
sequence is that they can run in the background while the user continues their work.

Data Management sequences are:

 l AppSnapshot_OSD

MonitorHealthEnv_OSD

 l MonitorHealthTask_OSD

 l RecycleAllTypesForced_OSD

 l RecycleAllTypesSmart_OSD

 l RecycleConsForced_OSD

 l RecycleConsSmart_OSD

 l RecycleDataMgmtForced_OSD

 l RecycleDataMgmtSmart_OSD

 l RecycleGenForced_OSD

 l RecycleGenSmart_OSD

 l RecycleStageForced_OSD
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 l RecycleStageSmart_OSD

 l SnapAutomation_OSD

Data Management steps are:

 l AppSnapshot_OSD

MonitorHealthEnv_OSD

 l MonitorHealthTask_OSD

 l RecycleAllTypesForced_OSD

 l RecycleAllTypesSmart_OSD

 l RecycleConsForced_OSD

 l RecycleConsSmart_OSD

 l RecycleDataMgmtForced_OSD

 l RecycleDataMgmtSmart_OSD

 l RecycleGenForced_OSD

 l RecycleGenSmart_OSD

 l RecycleStageForced_OSD

 l RecycleStageSmart_OSD

 l SnapAutomation_OSD

Data Management sequences used for application and environment snapshots, found in Task 
Scheduler for the System Diagnostic Automation task:

 l SnapAutomation_OSD

 l AppSnapshot_OSD
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Settings
The Settings page contains the Global Options tab in which key properties that guide 
administration are set as well as Uninstall tab, which provides solution uninstall options.

Global Options
The Global Options tab is used during the initial setup and configuration of System Diagnostics.

Smart Recycle CPU % Limit
This setting defines the maximum CPU % used on an application server that will allow a Smart 
Recycle to execute.

Smart Recycle User Activity Limit (secs)
This setting defines the time in seconds that there must be no user activity to allow a Smart 
Recycle to execute.

Unlimited User Proxy
This setting is used for Environment Statistics calculations for companies that have an unlimited 
user license agreement. If your company has an unlimited user license agreement, then adjust 
this setting to the closest actual number of users. Otherwise, the calculations are based on the 
licensed user-count and this setting is not used.

User Per CPU Adjustment
This setting allows the ability to manually adjust the derived value of users per CPU. Users per 
CPU is used in the Environment Statistics calculations.

System Diagnostics Guide 10

Settings



Uninstall
The Uninstall tab allows administrators to uninstall the System Diagnostics user interface or the 
entire solution. 

Note: If performed as part of an upgrade, any modifications made to the standard System 
Diagnostics objects are removed.

There are two uninstall options:

 l Uninstall UI removes System Diagnostics, including related dashboards and business 
rules, but leaves the database and related tables in place. Some Global Options will also be 
cleared because their values are stored in Parameters under Dashboards. 

Check the Release Notes to determine if this step is necessary. For some releases, this 
step should be performed before accepting a new version of System Diagnostics because 
some of the dashboards or other objects may have been modified.

 o Choose this option to accept a System Diagnostics update without removing the data 
tables.

 o The Release Notes indicate if an overinstall is supported.

 l Uninstall Full removes all the related data tables, all data, System Diagnostics 
dashboards, and related business rules.

 o Choose this option to completely remove System Diagnostics or to perform an 
upgrade that is so significant in its changes to the data tables that this method is 
required.

Note: The System Diagnostics tables are stored on the Framework database. Removing 
these tables also removes all related System Diagnostics data for all applications using the 
same Framework.
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System Diagnostics Home Page
Access the System Diagnostics Home page by navigating to OnePlace > Dashboards > 
System Diagnostics > System Diagnostics.

Starting System Diagnostics opens the System Diagnostics Home Page. Use this page to start 
the different analysis tools in System Diagnostics so you can monitor and diagnose overall 
environment performance and task health.

Click  in the System Diagnostics dashboard to return to the Home page.
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Analyze Environments
Use Environment Analysisto create environment snapshots by gathering information 
maintained by OneStream Environment Monitoring features.  The environment snapshots 
provide details on application and database servers, environment statistics, and task 
health.

Create an Environment Snapshot
 l To create an environment snapshot for a given point in time click Create. The new 

snapshot displays in a list on the left side of the dashboard panel with any other snapshots 
that have been created.

 l To change a snapshot name, click the name and change it,  and click Save 

 l To delete a snapshot, select the snapshot name and then click Delete.

Application Servers
The Application Servers pane shows data specific to the application servers.
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Recycle Application Servers
Recycling Application Servers lets you  restart the servers manually, with or without checking 
application activity. Manually recycling the application servers is needed to improve performance 
in certain environments due to PowerShell Automation and high concurrency that keep servers 
from recycling automatically.

Important: Recycling terminates all running processes on the application servers.

Recycle Types
Smart
This option evaluates the server activity with two tests before allowing a server to recycle. The 
settings for these tests are maintained in the System Diagnostics Global Options. The server 
activity tests must both be met before a recycle can be processed.

 l The server CPU activity percentage must be less than the Smart Recycle CPU % Limit 
(default = 1%).

 l The server idle user activity timer must exceed the target Smart Recycle User Activity Limit 
(default = 60 seconds).

Force
This option recycles without checking for server activity. Selecting this option logs off any users 
logged on to the application.

Recycle One
Recycles a specified application server by selecting the environment snapshot and the 
application server from the list.

Recycle All
Recycles all application servers.
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Database Servers
This section shows data specific to the database servers.

Application Server and Database Server data both display in a pivot grid, allowing you to sort and 
group records using the grid capabilities.

Analyze Environment Snapshot Data
Select an environment snapshot and click Analysis to view the Environment Snapshot 
data in a table with target, minimum, average, maximum, status, and indicators.
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Note: Any column headers can be dropped into the top row to be grouped by that column.

Environment Statistics Groups and Items
Environment statistics are grouped as follows:

 l Gen-Stage Concurrency: Shows concurrency statistics for General-type or Stage-type 
application servers.

 l Con-DataMgmt Concurrency: Shows concurrency statistics for Data Management-type 
or Consolidation-type application servers.

 l App Server Settings: Shows statistics for the application servers in non-Azure 
environments.

 l DB-Server Settings (Stand-alone) or DB-Server Resources (AzureSQL DB): Shows 
statistics for the database server in a stand-alone database server environment, or the 
AzureSQL Elastic Pool for Azure Cloud environments.

A) Gen-Stage Concurrency
Use items in this group to gain insight into the user load on your General-type or Stage-type 
application servers. 

Licensed User-Count
The total number of users licensed to access the application.

Licensed Concurrent-Users
The number of users that are currently logged onto the application.The value is the number of 
licensed users times the estimated concurrency.

GenServer Users-Per-CPU
This is the maximum number of base users per central processing unit (CPU) minus the shared 
server deflator and large data unit deflator, plus any CPU adjustment per user.

The shared server deflator is used to account for CPU utilization between servers.

GenServer Supported-Users
The number of General-type application server CPUs multiplied by estimated users per CPU.

GenServer Capacity-Variance
General-type application server concurrency minus estimated concurrency.
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GenServers Balanced
This indicates whether the CPU and RAM are consistent across General-type application servers. 
A value of 0.0 means the General-type servers' CPU and RAM are consistent across the 
application servers. A value of 1.0 indicates CPU and RAM are not consistent.

Number of Enabled User Licenses
Total users that have the "IsEnabled" General setting in the System security settings set to True.

Number of Disabled User Licenses
Total users that have the "IsEnabled" General setting in the System security settings set to False.

See also: The System Security Users and Groups section of the System Administration chapter 
of the Design and Reference Guide.

Actual Concurrent Logins
Count of the most concurrent user session logins across all platforms (desktop, browser) in the 
past 30 days. This includes users logged into multiple platforms at the same time.

Actual Concurrent Users
The peak number of actual, distinct users logged in at the same time in the past 30 days.

B) Con-DataMgmt Concurrency
Use items in this group to gain insight into the user load on your Data Management-type or 
Consolidation-type application servers. 

ConServer Required-Servers
Estimated concurrency divided by estimated users per CPU divided by standard application 
server CPUs, multiplied by General-type application server to Consolidation-type application 
server ratio.

ConServer Available-Servers
The current consolidation servers being used.

ConServer Capacity-Variance
The required Consolidation servers required less the available con servers. A value of 0.0 means 
consolidation servers are available. A value of 1.0 indicates that consolidation servers are 
required.

ConServers Balanced
This indicates whether the CPU and RAM is consistent across Consolidation-type application 
servers. A value of 0.0 means the consolidation servers' CPU and RAM are consistent across the 
application servers. A value of 1.0 indicates CPU and RAM are not consistent.

DMServers Dedicated
Indicates whether a dedicated Data Management-type application server is required.
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C) App Server Settings (Non-Azure Environment only)
The group reflects the settings for the application servers.

AppServer Minimum-RAM
The application server minimum is set at 28GB of RAM for cloud-based installs, otherwise 32GB 
of RAM.

D) DB-Server Settings or DB-Server Resources (for 
AzureSQL DB Servers)
The group reflects the settings for the database server in a stand-alone DB server environment or 
the AzureSQL Elastic Pool for Azure Cloud environments.

DB-Server Settings

DB CPU-Required
The database server CPU requirements are based on the following logic:

 l If estimated concurrency is less than 150 concurrent users, then the required CPU is 8.

 l If estimated concurrency is between 150 and 300 concurrent users, then the required CPU 
is 16.

 l If estimated concurrency is greater than 300 concurrent users, then the required CPU is 32.

DB CPU-Available
The current database CPUs being utilized.

DB CPU-Capacity-Variance
The available CPUs less the required CPUs for concurrent users.

DB RAM-Required
The database RAM requirements are based on the following logic:

 l If estimated concurrency is less than 75 concurrent users, then the required RAM is 128GB.

 l If estimated concurrency is between 75 and 150 concurrent users, then the required RAM is 
256GB.
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 l If estimated concurrency is between 150 and 300 concurrent users, then the required RAM 
is 512GB.

 l If estimated concurrency is greater than 300 concurrent users, then the required RAM is 
768GB.

DB RAM-Available
The current database RAM being utilized.

DB RAM-Capacity-Variance
The available RAM less the required RAM for concurrent users.

App-Framework DB-Server-Sharing
Indicates the database server sharing status.

DB-Server Resources

AzureSQL Edition-Check (Application)
Indicates whether the Azure SQL appplication database runs at a business-critical service level. A 
value of 1 equals yes. A value of zero equals no.

AzureSQL ServiceObjective-Check (Application)
Indicates whether the Azure SQL appplication database runs in an Elastic pool. A value of 1 
equals yes. A value of zero equals no.

AzureSQL Edition-Check (Framework)
Indicates whether the Azure SQL appplication framework runs at a business-critical service level. 
A value of 1 equals yes. A value of zero equals no.

AzureSQL ServiceObjective-Check (Application)
Indicates whether the Azure SQL appplication framework runs in an Elastic pool. A value of 1 
equals yes. A value of zero equals no.

Environment Statistics Status

Status Description

Informational Data point used in environment statistics calculations.

Ok Indicates that less than 25% of the evaluations are failing.

Warning Indicates that 25%-60% of the evaluations are failing.

System Diagnostics Guide 19

Analyze Environments



Status Description

Critical Indicates that more than 60% of the evaluations are failing. This displays 
in the Critical column.

Environment Analysis Reports 
Select the report type from the dropdown and click Go to run the report.

Error Log
This report reflects the Error Log activity for the previous 30 days based on the time of the 
snapshot selected.

Memory Manager
This report provides the Server Memory details over the previous 15-day period. Any events over 
10 days reflect a critical status.

Resource Validation
This report provides a detailed breakdown of the General Stage Concurrency, Consolidated-Data 
Management Concurrency, and Database Server Resources.

Server Detail
This report provides details for the application servers.

Server Startup
This report provides the Server Startup details over the previous 15-day period. Any day with zero 
start ups reflects a critical status.

Large Data Unit Detail 
This report reflects the top 200 data units from the Global Option sample year used to derive the 
large data unit deflator used in calculations.

Task Activity Log
This report reflects the Task Log activity for the previous 30 days based on the time of the 
snapshot selected.
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Analyze Applications
Application analysis lets you create application snapshots by gathering information 
maintained by the selected application and its database tables.The application 
snapshots provide details on key application metrics that can affect performance as well 
as an application’s data volume details.

Create an Application Snapshot
 1. Click  to create an application snapshot for a given point in time.

 2. A pop-up dialog prompts you to enter the Data Volume Year (the year to which the data 
volume statistics apply), Data Volume Detail (the number of top records recorded for the 
data volume statistics), and snapshot name. The snapshot name defaults to New 
Snapshot if you leave the snapshot name blank.

The new snapshot displays on the left side of the dashboard panel.

To change the snapshot name, select the name field, change the name, and click . To delete a 
snapshot, select the snapshot name and then click .

Application Metrics
This section shows the application metrics that are considered key stakeholders drivers in an 
application’s general performance.You can click on any row in the Application Metrics grid to view 
additioinal details of the records in that metric.

Stored Formulas
Applications that have a large number of stored formulas may notice a consolidation performance 
impact. Green Status: Less than 1000, Orange Status: 1000-2000, Red Status: Higher than 2000.
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Dimensions with over 1000 members
Multiple dimensions greater than 1,000 members can result in a large and sparse data model 
which can impact consolidation and reporting performance. Green Status: Less than 2, Orange 
Status: 2-3, Red Status: Higher than 3.

Members with Auto-Translate Currencies
Applications that use the Entity Auto Translate property will result in reduced consolidation 
performance. Green Status: 0, Orange Status: 1-20, Red Status: higher than 20.

Cubes with Non-Standard Consolidation or Translation Algorithms
Applications that use non-standard consolidation or translation algorithm types may result in 
reduced consolidation performance. Green Status: 0, Orange Status higher than 0. No Red 
status.

Attribute Members
Applications that have greater than 500 attribute members will have a negative impact on 
consolidation performance. Green Status: 0, Orange Status: 0-500, Red Status: higher than 500.

Number of Stored Records for Largest Data Unit
Data Units larger than 500,000 records may cause consolidation and reporting performance 
degradation. Green Status: less than 500,000. Orange Status: 500,000-750,000. Red Status: 
Higher than 750,000.

Number of Stored Records for Largest Workflow
Workflows with more than 1,000,000 finance load result records may result in reduced stage 
performance. Green Status: 1,000,000. Orange Status: 1,000,000-1,500,000. Red Status: higher 
than 1,500,000.

One to One Entity Relationships
Entity hierarchies with numerous one to one parent child relationships can result in poor 
consolidation performance. Green Status: 0, Orange Status: 1-5, Red Status: higher than 5.

Number of Finance Rules and Member Formulas Using BRApis
Finance Rules and Member Formulas that use BRApi functions can result in a degradation of 
consolidation performance due to these functions needing to open a database connection. 
Consider using API function equivalents whenever possible. Green Status: 0, Orange Status: 1-
10, Red Status: Higher than 10.

Number of Finance Rules and Member Formulas without Consolidation Conditions
Finance Rules and Member Formulas without consolidation if conditions can result in a 
degradation of consolidation performance due to the rule potentially needlessly firing at multiple 
levels of the consolidation dimension. Green Status: 0, Orange Status: 1-10, Red Status: Higher 
than 10.
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Number of Finance Rules and Member Formulas without Entity Conditions
Finance Rules and Member Formulas without entity if conditions can result in a degradation of 
consolidation performance due to the rule potentially needlessly firing for both base and parent 
entities. Green Status: 0, Orange Status: 1-10, Red Status: Higher than 10.

Number of Finance Rules and Member Formulas Using Active Error Logging
Finance Rules and Member Formulas that have active error logging still commented in can result 
in a degradation of consolidation performance due to these rules having to write to the error log 
during a consolidation. Green Status: 0, Red Status: Higher than 0.

Application Metrics Status

Status Description

Ok Indicates that less than 25% of the evaluations are failing.

Warning Indicates that 25%-60% of the evaluations are failing.

Critical Indicates that more than 60% of the evaluations are failing. 

Data Volume Statistics
This section reflects on the application’s data volume detail based on the year selected for the 
snapshot.
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Cube Data Volumes
Reports on the Cube, Scenario, Entity, and year combinations with the most data volume rows in 
the DataRecord database tables.

Stage Data Volumes
Reports on the workflows with the most data rows in the stagetofinanceloadresult database table.

Register Data Volumes
Reports on workflows with the most records that are found in the installed Register Plan database 
tables.

BiBlend Data Volumes
Reports on BiBlend data volumes in the StageBIBlendInformation database table.

Application Analysis Reports
Application Analysis reports are based on the selected snapshot time period. 

Snapshot Summary
Summarizes all the snapshot data found in the Application Metrics and Data Volume Statistics 
tabs into one PDF report.

Marketplace Solution Deployment
Reports on all the deployed Marketplace Solutions in the current application when the selected 
snapshot was taken.

Long Running Formulas
Reports on any Long Running Formulas logged in the error log during the previous 30 days from 
when the selected Snapshot was taken.

Compare Application Snapshots 
Click Compare Snapshots to compare any two application snapshot metrics. You can 
compare snapshots in the same application or different applications.
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Auto-Created Task in Task Scheduler
When the solution's tables are first set up, a task called System Diagnostics Snapshot 
Automation is created in Task Scheduler. Task Scheduler is only viewable on OneStream 
Desktop. This task runs monthly on the third Saturday of the month at 11:30 PM UTC. The task 
takes an environment snapshot, and also takes an application snapshot for the application where 
System Diagnostics was deployed.

If other applications in the same environment already have a System Diagnostics solution 
installed, a new System Diagnostics install in another application results in the task being 
scheduled to run 30 minutes before the existing System Diagnostics tasks in the environment to 
ensure environment resources are not exhausted by having several application snapshots run at 
the same time.

See also: Create Tables

Modify the Task
Administrators can modify the Snapshot Automation OSD task to change the frequency or 
scheduled time of the Automated Snapshot:
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 1. Navigate to the Task Scheduler page in OneStream (Application > Tools > Task 
Scheduler).

 2. Select the task called Snapshot Automation OSD and click Edit.

 3. Click the Schedule tab and change the frequency and scheduled time as needed. See the 
Task Scheduler section in the Design and Reference Guide for more information on using 
the Schedule tab.

Re-Create the Task (After deleting)
If the task gets deleted for any reason, and the administrator user wants to re-create the task there 
are two options.

 l Find the dashboard 0_Frame_OSDS under the dashboard group Solution Setup (OSDS) 
and run it. Then click Setup Tablesto create the task.

 l Manually create a task with the desired frequency and select the SnapshotAutomation_
OSD sequence.Then set the Year parameter to the current year and the Data Volume 
parameter to 10, as shown in the following:
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Analyze Tasks
Task Analysis provides the ability to research tasks by concurrency, statistics, and 
overall counts. Click Task Analysis on the System Diagnostics Home page to start your 
research on the Task Analysis page.

The Task Analysis page also provides access to the Task Concurrency, Task Statistics, and 
Task Counts pages.

The following image shows the data concurrency chart on the Task Analysis page. This is the 
first page that displays when you click Task Analysis on the System Diagnostics Home page.

Create Charts 
All pages available in Task Analysis work the same way. Select criteria at the top of the page that 
determines the data that displays on the chart. Criteria includes the following:

Evaluation Date
The date for which you want evaluation data to start.
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Evaluation Days
The number of days prior to the Evaluation Date to evaluate and include on the chart. For 
example, if you select 2021-07-22 as the Evaluation Date and 15 for the number of evaluation 
days, the chart reflects data from 2021-07-22 to 2021-07-07.

Application
Select the name of the application you want to analyze data from the list . Applications in the list 
are base on your security role.

App Server
Select a specific application server to search or select the default (All) to include all application 
servers.

Task Type
Select a specific task type to evaluate or select the default (All) to include all task types.

Env Snapshot (Task Concurrency Only)
Select the snapshot that contains the data you want to use as the source for daily concurrency 
charting.

To create a chart:

 1. Use the fields at the top of each of these pages to determine the the data used for charting.

 2. Click Refresh Charts to create the chart based on the defined criteria.

 

to run a Daily Concurrency compared to environment resources.

Tip: Click Print to generate a printable version of the Daily Concurrency chart.

Task Analysis Page
The Task Analysis page lets you query the number of tasks running in parallel over a given time 
frame by application, application server, task type, and environment snapshot. Use the Task 
Analysis page to run a daily logon concurrency chart compared to environment resources.

The data is represented as a line chart in the Task Analysis page, with each line representing a 
daily concurrency type. Check boxes at the top of the chart let you exclude logon types. 

You can also hover over data points of the lines in the chart to to see a count of concurrent logons 
for the highlighted logon type in a pop-up. Data points occur on each date on the chart as defined 
by the evaluation criteria. 
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You click on a point in the chart to update the chart using the date for that point as the starting 
date. The following image shows an example of this. The snapshot date is 2021-07-21, but the 
chart data starts at 2021-07-06, because a data point on that date was clicked, which cause the 
chart to update using that date as the evaluation start date.

Task Concurrency
Task Concurrency lets you query the number of tasks running in parallel over a given 
time frame by application, application server, task type, and environment snapshot.

Task Concurrency bar chart data is based on the currently selected criteria. Each bar represents a 
day during the evaluation period. Each color in a bar represents either a task type defined using 
the evaulation criteria, or a selected logon type.

Like Task Analysis charting, check boxes at the top of the Task Concurrency chart represent the 
different logon concurrencies being tracked based on the evaluation criteria. Select or clear check 
boxes to show or hide logon types in each bar on the chart. 

System Diagnostics Guide 29

Analyze Tasks



View Daily Concurrency Details 
Click on any bar on the Daily Concurrency chart to view the detail for that day in a separate bar 
chart. The Hourly Activity chart uses a bar to represent each hour increment of the day selected in 
the Daily Concurrency chart. The chart's left axis labels are for each two-hour increment in the 
day.
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Click on any bar on the Hourly Concurrency chart to view the detail for that hour in a separate bar 
chart. The Minutely Activity chart uses a bar to represent each minute increment of the hour 
selected in the Daily Concurrency chart. The chart's left axis labels are for each four minute 
increment in the hour.
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Click on any bar on the Minutely Concurrency chart to view specific logon detail, along with any 
task or error detail for that minute in a separate Detail Application window. 
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Task Statistics
Task Statistics provides the ability to query the minimum, maximum and average 
durations in seconds by date, application, app server, and task type.

Selecting or clearing Min, Avg, or Max in the statistic key updates the Daily Task Statistics chart.

Task Counts
Task Counts provides the ability to query the number of tasks completed over a given 
time frame by application, app server, and task type.
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Selecting or clearing Complete, Fail, or Cancel in the Task key instantly updates the Daily Task 
Counts chart.
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Monitor Environment and Task 
Health

Live Monitoring provides Environment and Task health data for a given time frame.

Monitor Environment Health
This section provides a way to check the application environment health by different time frame 
durations and intervals.

To help differentiate between different EnvHealth live monitoring sessions, the Description field 
can be changed by selecting the Description field, change the Description click Save.  EnvHealth 

sessions can also be deleted by selecting them from the list and clicking Delete Row .

Duration
Set the Duration length of time to monitor from a range of 1 minute to 12 hours.
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Interval (Seconds)
Set the Interval period(s) to monitor from a range of 10 to 600 seconds.  The first monitoring point 
will be at the interval time selected with additional point being recorded at each interval.

Note: Running short intervals over long durations may impact system performance. An 
interval of 60 seconds or greater should be used for longer duration monitoring.

Click  to run the Environment Health monitoring job.

Select the job by highlighting a row and select from one of the three output methods, Analysis, 
Pivot, or Report.

Analysis
Select Analysis to view the Environment Health Monitoring data in a table with target, 
minimum, average, maximum, status, and critical health indicators.
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Environment Health Monitoring Status

Status Description

Informational Data point that is used in environment health monitoring calculations.

Ok Indicates that the metric does not affect application performance.

Warning Indicates that the metric may negatively affect application performance.

Critical Indicates that the metric is negatively affecting application performance.

Environment and Task Health Monitoring Status

Status Description

Informational Data point that is used in environment health monitoring calculations.

Environment and Task Health Monitoring Groups / 
Items

A) Application Concurrency
Total Logged on Users
The number of users logged on to the environment compared to the number of users that the 
environment can support.

If the number of users logged on to the environment is greater than the supported limit for the 
environment, UI and reporting performance may degrade to the point of requiring an IIS Recycle.

Running Task Total
Total concurrent tasks in progress at the time of the monitoring.

Running Tasks Type
Total tasks in progress by the type at the time of the monitoring.

Running Tasks Server
Total tasks in progress per server at the time of the monitoring.
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B) App Server Health Items
Memory in Use
The total memory that is being used by OneStream processing.

Server Memory in Use
The total memory that is being used by the application server.

Total Memory
The total memory that is available on the application server.

Memory Utilization
Amount of Memory used for the Analytic Cache and all other Caches.

The reserve Memory must be large enough to hold all Non-Analytic cached items, Metadata, 
Workflow, Stage Processing, Etc. If this value is consistently high and gets above 90%, Reserve 
Memory should be increased because Non-Analytic memory consumption is larger than the 
reserve and virtual memory pressure grow.

CPU Count
The number of CPUs on the application server.

CPU Utilization
CPU activity for the specified Application Server as a percentage of 100.

High CPU usage is common for Consolidation, Data Management and Stage servers. However, 
CPU utilization should fluctuate for General Servers (Consistent high CPU Utilization on General-
type application servers indicates more General server CPUs are required).

Server Logged on Users
The number of users logged onto the application server.

If the number of users logged on to the environment is greater than the supported limit for the 
environment, UI and reporting performance may degrade to the point of requiring an IIS Recycle.

C) DB Health Items - (Displays for Application & Framework 
DBs)
System CPU Utilization
CPU activity for the specified Database Server.  This will not display in AzureSQL Elastic Pool DB 
environments.

High CPU usage is common for Consolidation, Data Management and Stage servers. However, 
CPU utilization should fluctuate for General Servers (Consistent high CPU on General servers 
indicates more General server CPU's are required).
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SQL Server CPU Utilization
CPU activity for the specified Database SQL Server.  This will not display in AzureSQL Elastic 
Pool DB environments.

High CPU usage may be a factor of high concurrency on the system and may be an indicator of IO 
resource bottlenecks (Excessive locks, disk queue management, etc.).

Blocking Transaction Count
The number of transactions that are delayed or stopped from processing in the database.

Page Life Expectancy
Average expectancy for how long each data page is staying in a buffer cache before being flushed 
out to make room for other pages.

A value below 3000 indicates memory pressure (Below 1000 represents extreme memory 
pressure). Example:  A server with 230GB RAM allocated to the SQL Server buffer pool and a 
Page Life Expectancy of 300 would equate roughly to 785MB/sec of I/O activity to maintain the 
page churn inside of the buffer pool. While it might be possible for the I/O subsystem to keep up 
with this demand, this represents a significant number of page churn in the buffer pool.

Buffer Cache Hit Ratio
Indicates the percentage of pages that were found in the buffer pool without having to incur a read 
from the disk.

The recommended value should be between 95 And 100. A lesser value indicates memory 
pressure.

Memory Grants Pending
Indicates the number of processes waiting on a workspace memory grant.

A higher value indicates the server needs more memory.

Total Server Memory (GB)
Amount of memory that a server has committed using the memory manager.

Target Server Memory (GB)
Amount of memory that a server is willing to allocate to the buffer pool under its current load. The 
Target Server Memory value shows how much memory the SQL Server needs for the best 
performance.

Total-Target Memory Ratio
Total Server Memory / Target Server Memory

When the Total Server Memory and Target Server Memory values are close, there’s no memory 
pressure on the server. The recommended ratio value should be 1.

Total Connection Count
The number of client connections accessing the database.
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High connection count near the target means that the MaxPoolSize of the SQL Connection should 
be increased, or connection time-outs may occur.

Total Select Count
The number of select statements executed during the monitor period.

Total Insert Count
The number of insert statements executed during the monitor period.

Total Update Count
The number of update statements executed during the monitor period.

Total Delete Count
The number of delete statements executed during the monitor period.

Lazy Writes/Sec
Indicates the number of times per second the server relocates dirty pages from buffer pool to disk.

The recommended value for Lazy Writes/Sec is below 20.  Higher paging and disk I/O activity 
indicate insufficient memory. Check Page Life Expectancy and if its value is low (below 1000 
seconds), then this is a clear indication of memory pressure.

Page Reads/Sec
Indicates the number of physical database page reads that are issued per second. This statistic 
displays the total number of physical page reads across all databases.

The recommended Page Reads/Sec value should be under 90. Higher values indicate insufficient 
memory and indexing issues.

Page Writes/Sec
Indicates the number of physical database page writes that are issued per second.

Recommended value for Page Writes/Sec is below 90.  Higher paging and disk I/O activity 
indicate insufficient memory.

Pivot
Select Pivot to view the Environment Health Monitoring data in a table by the number of 
interval evaluations that were selected.
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Reports
Select Report to view the Environment Health Monitoring analysis and detail.

Env Health Analysis
This report provides the Environment Analysis for the Application and Database Servers.

Env Health Analysis (With Explanations)
This report provides the Environment Analysis for the Application and Database Servers with 
explanations.

Env Health Detail
This report provides the Environment Detail for the Application and Database Servers.

Monitor Task Health
This section provides a way to check the task health by different task types, durations, intervals 
and evaluations.
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Task Type
Set the type of task to monitor.

Duration
Set the Duration length of time to monitor tasks from a range of 1 minute to 12 hours.

Interval (Seconds)
Set the Interval period(s) to monitor tasks from a range of 10 to 600 seconds.

Seconds Before Flag
Set the Seconds Before Flag to capture tasks that have been processing for more than a 10 to 
6000 second runtime.

Evaluation Before Log
Set the Evaluation Before Log from a range of 1 to 10 to determine the number of times to skip 
logging the task if the task has exceeded the seconds before flag.

Select Go to run the Task Health monitoring job.

Select the job by highlighting a row and select from one of the three output methods, Analysis, 
Pivot, or Report. 

Reports 
Select Report to view the Task Health Monitoring analysis and detail.

Task Health Analysis
This report provides the Environment Analysis for the Application and Database Servers.
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Task Health Analysis (With Explanations)
This report provides the Environment Analysis for the Application and Database Servers with 
explanations.

Task Health Detail
This report provides the Environment Detail for the Application and Database Servers.

Unhealthy Tasks
This section will reflect any tasks that are not processing successfully for a given monitoring time 
frame.
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Help and Miscellaneous 
Information

This page contains solution documentation.

Display Settings
OneStream and MarketPlace solutions frequently require the display of multiple data elements for 
proper data entry and analysis. Therefore, the recommended screen resolution is a minimum of 
1920 x 1080 for optimal rendering of forms and reports.

Additionally, OneStream recommends that you adjust the Windows System Display text setting to 
100% and do not apply any custom scaling options.

Package Contents and Naming Conventions
The package file name contains multiple identifiers that correspond with the platform. Renaming 
any of the elements contained in a package is discouraged in order to preserve the integrity of the 
naming conventions.

Example Package Name: OSD_PV6.2.0_SV100_PackageContents.zip

Identifier Description

OSD Solution ID

PV6.2.0 Minimum Platform version required to run solution

SV100 Solution version

PackageContents File name
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Solution Database Migration Advice
A development OneStream  application is the safest method for building out a solution with custom 
tables such as this one. The relationship between OneStream objects such as workflow profiles 
and custom solution tables is that they point to the underlying identifier numbers and not the 
object names as seen in the user interface. Prior to the solution configuration and to ensure the 
identifiers match within the development and production applications, the development 
application should be a recent copy of the production application. Once the development 
application is created, install the solution and begin design. The following process below will help 
migrate the solution tables properly.

See also: Managing a OneStream Environment in the Design and Reference Guide.

 1. In the production OneStream application, install the solution and create the data tables. 
See Configure the OneStream Application Server for Database Server Connection settings 
and installation details. 

 2. Data tables are created in the OneStream  Development application during the solution 
installation. Using the Microsoft Data Migration Assistant, copy the data from the tables to 
the Production Microsoft SQL Server Database. Only the Microsoft SQL Administrator 
should run the migration assistant.

Important: This process has the potential to overwrite existing table data in the production 
application database if data already exists.
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MarketPlace Solution Modification 
Considerations
A few cautions and considerations regarding modification of MarketPlace solutions: 

 l Major changes to business rules or custom tables within a MarketPlace solution will not be 
supported through normal channels as the resulting solution is significantly different from 
the core solution. 

 l If changes are made to any dashboard object or business rule, consider renaming it or 
copying it to a new object first. This is important because if there is an upgrade to the 
MarketPlace solution in the future and the customer applies the upgrade, this will overlay 
and wipe out the changes. This also applies when updating any of the standard reports and 
dashboards. 

 l If modifications are made to a MarketPlace solution, upgrading to later versions will be more 
complex depending on the degree of customization. Simple changes such as changing a 
logo or colors on a dashboard do not impact upgrades significantly. Making changes to the 
custom database tables and business rules, which should be avoided, will make an 
upgrade even more complicated.
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